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I. Thermistor Data Organization 
One suggestion is to set up a folder system on a shared drive to look something like this:
Thermistor Data  Thermistor Data YearXX  RAW  Excel 
 						 	      Tidbit 
Thermistor Data  Thermistor Data YearXX  Final
						
Folder description:
· RAW: to store all of the raw and unformatted Tidbit and Excel files 
· Final: to store all of the final tab delimited files (.txt) ready to be uploaded into SWIMS
· Must be properly formatted following the outline in the Meter Matrix (LINK TO WHERE THE METER MATRIX IS) and directions in this protocol (Section III. Downloading data from Tidbits to the Computer) 

[image: C:\Users\anderc1\AppData\Local\Temp\SNAGHTML1723eea.PNG]


II. Launching Thermistors
Shown below are the continuous temperature data loggers types most commonly used by DNR staff:
[image: ]
1. Open the HOBOware software on your computer .

2. Connect the HOBO Shuttle to the computer using the USB cable provided with the shuttle (Optic USB Base Station or HOBO® Waterproof Shuttle) and choose the appropriate coupler for the thermistor.

[image: ]

Each kind of thermistor (above) requires a specialized coupler (below). 
 [image: ]
Please make sure that the coupler is securely attached to shuttle before attempting to launch the thermistor or download data as a secure connection is needed so that the devices can communicate with each other.

3. Insert a TidbiT or Hobo pendant into the coupler attachment on the shuttle. Make sure that the communication LEDs are facing towards the shuttle when attaching (as shown in the diagrams below). 

[image: ][image: ]

    Hobo Water Temp Pro v2 Pendant 					TidbiT® v2 Temp

4. Momentarily press the coupler lever (pressing hard enough so the lever bends) and wait for the indicator lights on the shuttle to light up - which will indicate fail (red), transfer (yellow) or OK (green). Once the light has turned green, the computer will be able to detect the thermistor.

If the connection fails (red light), try removing the thermistor and cleaning the dirt off the lights on the Tidbit/Hobo before resetting it in the shuttle. Squeeze the lever arm again to attempt to make the connection between the thermistor and the shuttle.
  
5. Once the indicator light on the shuttle is green, open the HOBOware Pro software. The serial number for the data logger will be listed at the bottom of the screen.

[image: ]

On the menu bar at the top of the screen, select the Device tab and choose ‘Launch’. You can also select the ‘Launch’ icon under the File tab (shown below in the red box).

[image: ]

6. A pop-up window will appear on the after the ‘Launch’ option has been selected. Make sure the serial number shown matches what is written on the thermistor and select ‘OK’.

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLb03d8f.PNG]
7. A second pop-up window may warn you that any logged data still on the thermistor will be deleted. If this window appears, hit ‘OK’. If this window does not appear during your launch process, don’t worry. Just continue to launch the data logger as described below.

8. A third pop-up window will appear with launching details for the thermistor. For Tidbits, click the ‘Status’ button in the top left corner of the window to check that battery level is still good (new bat is 3V, less than 2.7V is too dead to deploy).  Click ‘OK’ to go back to Launch window. 
FYI - A typical data logger should last about 5 years.

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLb48d92.PNG]

9. Both the ‘Temperature’ and ‘Logger’s Battery Voltage’ boxes should be checked. The logging interval should be set at 1 hour unless your program or supervisor directs you to do otherwise.

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLb2c036.PNG]

10. Go to ‘Start Logging’ and use the drop down menu to select the date and time that you want the thermistor to begin logging (Now, At interval, On Date/Time, Using Coupler) and then click ‘Start’ (or ‘Delayed Start’ if you are opting to have the thermistor begin logging at a future date and time).  

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLbe1eaa.PNG]

11. [image: ]On the HOBOware Pro screen, check the bottom left corner for the results of the thermistor launch process. Your thermistor was launched successfully if it says ‘Launch Successful’.

12. [image: ][image: ]Remove the logger from the shuttle and check that the ‘ok’ light on the face of the thermistor is blinking. If there is no blinking light, repeat the steps listed above to relaunch the thermistor. If the light is blinking, the thermistor is working and it is ready to be installed it at your monitoring location. Communication window where you will be able to see if the light is blinking

1

III. Downloading Field Data from Thermistors

1. Make sure you have some sort of folder structure set up on your computer to store the RAW data files as well as the FINAL cleaned up files (see top of document).

2. Open the HOBOware Pro software on your computer and connect the shuttle to your computer. Place your thermistor in the coupler, gently squeeze the arm on the coupler, and wait for the ‘OK’ light on the shuttle to illuminate. You will also see the serial number of the thermistor listed along the bottom of the Hoboware Pro screen.

 [image: ]

3. Looking at the menu bar along the top of the screen, select the Device tab and choose ‘Readout’. You can also select the ‘Readout’ icon under the Device tab (shown below in the red box).
[image: ]





4. Click ‘OK’ on the pop-up window once the computer has found the shuttle. Make sure the serial number matches what is on the thermistor.

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLb03d8f.PNG]

5. [image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLda96f5.PNG]When prompted, choose to ‘Stop’ the logger before reading out the logger. The data should then download to your computer. If you select ‘Don’t Stop’, the thermistor will continue to log temperature data after your data is downloaded from the thermistor

6. Next, you will be prompted to save the file. Save the data file in the RAW subfolder for TidbiT data. Please discuss with your supervisor the preferred naming convention that you should use. One suggestion is to follow the naming convention: DeviceType_serial number_ProjectName_Station#.hobo                                                      
For Example: TIDBIT_97160016_OtterCreekBowersLakeRd_10028741.hobo





7. [image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLeaf319.PNG]Once saved, the Hobo file will open in the Hoboware Pro software. You will then be prompted with a pop-up window (‘Plot Setup’) directing you to select the parameters for that will be used to plot the data.

On the ‘Plot Setup’ window, please select the following:
· ‘Temp’
· Be sure to change from Fahrenheit to Celsius
· ‘Batt’ 
· The battery voltage should be reviewed to make sure power was never lost while the thermistor was deployed and to see if the thermistors end of life is drawing near (approaching 2.7V)
· Internal Logger Events
· Check all or none. It is your preference how much of this information you choose to see. Selecting ‘none’ won’t impact the rest of the data downloaded from the thermistor.

Once you have selected the plot parameters, hit ‘Plot’ to view your data.

8. Review data and make sure the dates displayed make sense (Blue is Battery data, black is Temperature data).

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLe9bd98.PNG]
9. Go to the File tab at the top of the screen and select ‘Export data table’. 

10. In the ‘Export’ window, mark the check boxes of the parameters that you want to export and then click ‘Export’ in the bottom right hand corner of the screen. 

[image: C:\Users\albrilb\AppData\Local\Temp\SNAGHTMLeef126.PNG]

11. When prompted, save the file (using the same file name as before) in the RAW subfolder for Excel spreadsheets. The exported data will be saved as a .csv file.

12. Remove the thermistor from the coupler and close the HOBOware Pro plot window. The thermistor should no longer be blinking.

IV. Formatting the Data for Upload to SWIMS

1. Now you need to format the Excel file:[image: ]
a. Delete the first row that says ‘Plot Title’ (a quick way to do this is click on 1 to highlight the row, right click, and then select delete). 
b. Delete the first column with all of the numbers 
c. Delete all temperature data that was logged when the thermistor was out of the water (in the office, transportation to/from stream) 
i. You will usually notice a spike in temperature at these time points at the beginning and end of file  
d. Change the remaining column headers to ‘Date Time’ and ‘Temp (ºC)’.
e. Graph the battery voltage information in the ‘Batt’ column to make sure that the thermistor did not lose power while it was in the stream. 
i. To view the curve and look for any spikes in the data, select the ‘Batt’ to highlight the data. Click the ‘Insert’ tab and choose the Line Chart graph. 
ii. After viewing the graph, you can delete it.
f. Delete all the data except the ‘Date Time’ and ‘Temp (ºC)’ columns (‘Batt’ should be deleted). 
g. **Tip: Can’t have any spaces after the last column of the text file.

2. Make sure you graph the data before uploading it into SWIMS by first selecting both the ‘Date Time’ and ‘Temp (ºC)’columns to highlight the data. Click the ‘Insert’ tab and choose the Line Chart graph. The temperature data should now be displayed in a nice curve reflecting the change in water temperature from spring until fall. If you see spikes in the temperature data, click on the line at the spike to show the row number. Scroll down to view the spikes in the data.  Try to evaluate why there is a spike – out of water, warm water discharge upstream, battery issues? Do not upload questionable data to SWIMS. 

3. Once the file is ready for uploading (you have removed the data from when it was out of the water), save as .txt file (Tab Delimited) using same naming convention as shown above (or however your supervisor instructs you to save it) and save in the appropriate FINAL folder.

V. Uploading Data into SWIMS

Before getting started, you will have to make sure that you are on the Project and that the Monitoring Station is on the project! If you have problems doing this because of limited SWIMS permissions, contact a SWIMS data manager (Matt Rehwald or Lisa Helmuth).

1. Log into SWIMS http://prodoasint.dnr.wi.gov/swims/login.jsp
 
2. Each region should have a general Meter Data Project (for thermistors that aren’t being collected for a more specific project) (see Step 5).
3. [image: ]If you want to add data to the regional Meter Data projects, add yourself to the project if you are not already on it.  Then also add the station to the project.  The Continuous Data Upload Form is already attached to these projects.  If you have problems doing this because of limited SWIMS permissions, contact a SWIMS data manager (Matt Rehwald or Lisa Helmuth).

4. For Regional Meter Data Projects: from My Projects choose your project and in Tasks choose Enter New Field Results.
[image: ]
5. Double check that you chose the correct Project, Data Collectors, Station, and Start Date for the fieldwork event (changes can be made by selecting the drop down arrows in the red boxes).

[image: ]

6. It is common that the Continuous Data Upload form may not be attached to the project (and station in that project) you want to put the thermistor data on so you may have to click on the Binoculars to search for that form and add it in. 
*Skip to Step 13 if the Continuous Data Upload form is already attached to your project

[image: ]
[image: ]
7. Click the binoculars to the right of the Form. In the query form window type “continuous” in the Form Code and click ‘Submit’. 

Click the back arrow to select “Continuous Data Upload” and go back to the main data entry form. 
[image: ]




Note: If you’ve already gone through this step in a data upload session, this may appear in the dropdown menu under Forms without needing to click on the binoculars to the right of the form field).



8. You may ignore the boxes requesting the ‘End Date’ and ‘Time’. The upload process will not be impacted if this information is not included. Fill in the comments field with information about where the thermistor was placed in the stream or any other information that you want associated with this fieldwork event.

[image: ]

9. Please take a second to reconfirm that the station and project match and confirm the dates and times that you enter.  Click the ‘Next’ button at the bottom.







10. Double check the station and project are correct and click ‘Save and Upload Continuous Data’ (do not enter any field data on this page. Use normal volunteer data form to enter all field data).

[image: ]

11. On the ‘Continuous Monitoring File Upload’ page, follow the steps listed below to upload your data.
A. Attach the file by clicking on the ‘Browse’ button and selecting the .txt file from the Final folder
B. Choose Type (most will use the Tidbit –Celsius option even if it is a Hobo type)

[image: ]

C. Click on Search for Method button
[image: ]

D. Always Choose Method Code: sondes (even if not a sonde)
     And Method Status: Active Methods Only
[image: ][image: ]
E. Click on the black Backfill Arrow[image: ]
Click the ‘Upload File’ button once you have filled in the top three boxes (leave the other two blank)
[image: ]

You will then see a screen that tells you it will take a little while to load your file.  

12. Depending on the file size, it may take a while for the data to load, but should be less than 2-4 minutes. Go back to the project and click on the field event to see if the data is there by going to:
A. My Projects tab/choose project/ Task ‘Project Overview’
[image: ]
B. [image: ]My Projects tab/choose project/Task ‘Edit Project Details with Wizard’/Monitoring Tab/ Fieldwork Events
13. As you can see in the image below, temperature Field Results and Summary Results (calculated metrics) are shown. If your data does not appear, check the .txt formatting and contact a SWIMS manager (Lisa Helmuth). If you upload the file multiple times, be sure to have a SWIMS manager delete the files so there is only one data set represented in SWIMS.












**Tip: Make sure the number of rows in original raw data file and Field Results match.
[image: ]

A. [image: ]Important! Click “Enable Edit” and type the appropriate logger device (“Tidbit”, “TidbitV2”, “HOBO”). Click “Save and Return”










B. You can also easily graph the data at this point by clicking on Reports/Graphs (lower lefthand side)/ Choose Continuous Temperature Data.
[image: ]

[image: ]
The graph readout of your field data will look like the graph below. You can choose to either print it or save it to your Desktop or thermistor folder from this window.

[image: ]
C. Done!

VI. Data Transfer Interfaces & Additional Information - When Good Thermistors Go Bad

HOBO Water Temperature Pro v2 Data Logger - U22-001 Optical Interface for Data Transfer
[image: ]

TidbiT v2 Water Temperature Data Logger - UTBI-001 Optical Interface for Data Transfer[image: ] 

Eventually the battery in the logger will die.  The light may continue to blink even if there is not enough battery life left to connect to the computer.  If you get an error in trying to connect a logger to the computer, contact Onset to confirm the problem is really a dead battery (and not user or software error).  If the battery is dead and you can’t get your data off of it, you can send it in to Onset (call them first to get an RMA or SRO number) and they can get the data off of it for you for a small fee (~$29). In Madison, dead thermistors can be recycled at Clean Sweep.  
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COMPLETE | 100416 ¢ Dos2ese
05/23/2014  COMPLETE 10028883 Hatton Creek 100 Ft Downstream From Clarks Mil Rd Brdge. 105673140
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